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- Read all safety precautions thoroughly to ensure safe use.

- Types of software installed on your computer varies depending on the method of installation from the
Software CD-ROM. For details, see the “Camera User Guide”

« For information on the operating systems that support the Software CD-ROM, see the “Camera User
Guide”.



Using These Manuals

The two manuals included are for your G700SE.

1. Understanding How to Use Your
Camera

“Camera User Guide” (Printed manual)

This guide explains the usage and functions of
the camera. You will also see how to install the
provided software on your computer.

2. Downloading Images to Your
Computer

“Software User Guide”
*This manual (this file)

This guide explains how to download images
from the camera to your computer.

Software

for Windows / Macintos
Operation Manual

3. Displaying Images on Your
Computer

The provided software “MediaBrowser” (for
Windows only) allows you to display and edit
images on your computer.

For details on how to use MediaBrowser, click
the [?] button on the MediaBrowser window
and see the “Help”

For the latest information about MediaBrowser,
access the Web page of Pixela Co., Ltd. (http://
www.pixela.co.jp/oem/mediabrowser/e/).

How to Use the Software User
Guide

Display examples:

The display examples may be different from actual
display screens.

Terms:

In this guide, still images and movies are
referred to as“images” or “files”.

Symbols:

This guide uses the following symbols and
conventions:

} )

This indicates important notices and restrictions
for using this camera.

)=

This indicates supplementary explanations and
useful tips about camera operations.

)

This indicates page(s) relevant to a particular
function.“IZ& P. xx" is used to refer you to pages
in this manual.

1

This indicates terms that are useful for
understanding the explanations.


http://www.pixela.co.jp/oem/mediabrowser/e/
http://www.pixela.co.jp/oem/mediabrowser/e/
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Chapter 1
Downloading Images
to Your Computer

(Windows)

This section explains how to download still images and movies to
your computer (Windows).



Downloading Images

There are two methods for downloading
images from the camera to your computer.

1. Downloading images without using
image download software such as
DL-10 (IZ5"P.6).

The camera is recognized by the computer
as a separate drive and appears on [My
Computer]. Select and copy images.

2. Use image downloading software such
as DL-10 to download all images to the
computer (IZ5 P.7).

To use DL-10, DC Software must be installed.
For information on how to install
DC Software, see the “Camera User Guide”.

} )

« Do not turn off the camera or disconnect the
USB cable during image transfer. The files will
not be written correctly.

« Do not use the computer to format the SD
memory card or the internal memory. Use the
camera to format the SD memory card or the
internal memory.

« Be sure to stop the connection before
removing the USB cable.

« The camera can not display pictures that
have been transferred to the computer using
“Windows Photo Gallery” (Windows Vista) or
“Windows Live Photo Gallery” (Windows 7) and
then copied from the computer to a memory
card which is subsequently inserted in the
camera.

+ Only one Ricoh digital camera can be
connected to one computer. Do not connect
multiple Ricoh cameras to one computer at the
same time.

« The names for DC Software items differ from
the names for Caplio Software items provided
with previous models as shown below.

Caplio Software DC Software
RICOH Gate La DL-10
Caplio Viewer DU-10
Caplio Server SR-10
Caplio Setting ST-10

)=

« When downloading images from your camera,
load a battery with adequate remaining power
in the camera.

« If there is an SD memory card in the camera,
images will be loaded from the card. If there is
no SD memory card in the camera, images will
be loaded from the internal memory on the
camera.

+ The software included in the CD-ROM can only
be used with Windows.



Downloading Images Without From the displayed drive, copy a
Using DL-10 file to the desired location.

The figure below shows the folder
configuration of the drive.

Make sure that the camera power is

off. g® RICOHDCX
Connect the accessory USB cable to é_‘ng?IM
a USB port of your computer. ] 100RICOH

RIMG0001.jpg
RIMG0002.jpg

: .
. When the contents of the internal memory
| are displayed, the drive name is [RICOHDCI].

Connect the USB cable to the USB - If afile with the same name already exists at

terminal of your camera. the destlnatlon', |jc is overwritten.
- If DC Software is installed, clear the check

box next to the [Saves automatically when
connected to USB] option in the DL-10 [Option
settings] dialog box.

Your camera turns on.

Your computer automatically reads the file
necessary for recognizing the camera as a
drive.

After this preparation, the camerais
displayed as a drive at [My Computer].

Example of the display in Windows XP



Downloading All Images
Using the DL-10 Software

DL-10 automatically creates a folder called
[Digital Camera] inside your [My Documents]
folder. Downloaded images are saved in
folders with the date of each shot, inside the
[Digital Camera] folder. (The files will continue
to be saved in the [Caplio] folder if you were
previously using Caplio Software.)

Set the correct date and time on the camera
before shooting.

Make sure that the camera power is
off.

Connect the USB cable to the USB
port of your computer.

/
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Connect the USB cable to the USB
terminal of your camera.

The camera turns on, DL-10 starts, and the
DL-10 window appears.

Image transfer begins automatically.

If image transfer does not begin, please try
the following procedures:

« Click the [Save] button in the DL-10
window.

« Restart your computer and perform
Steps 1 to 3 again.

- Confirm that the [Saves automatically
when connected to USB] checkbox in the
[Option settings] dialog box for DL-10 is
selected.

} )

» When the [The same image will not be saved]
check box is selected in DL-10 [Option settings]
(IZ5°P.11), the total number of files that can
be transferred at one time is 999. To transfer
1000 files or more, transfer 999 files first and
then click [OK] when the dialog box with the
number of remaining files appears. After that,
click the [Save] button in the DL-10 window
or reconnect the USB cable to transfer the
remaining files.

« Do not turn off the camera or disconnect
the USB cable during image transfer using
DL-10 (when the message for receiving data is
displayed).

)=

« The images on the computer are renamed
using consecutive file numbers; the file names
assigned by the camera are not used.

« Even when the storage folder is changed, the
file number will be continuous. The number
cannot be initialized.

« When transferring images to a computer
using DL-10, the files are assigned names like
[RIMG**** jpg] (**** indicates the number of
the image), even if [Card Sequence No.] is set
to [On].

)

- For details about DL-10, see P9.

« For details about the DL-10 [Option settings]
dialog box, see P.11.

» To disconnect the camera from your computer,
see P9.



Warning Messages Under
Windows XP Service Pack 3 and
Windows Vista Service Pack 2

When software for your Ricoh digital camera

is used on a computer running Windows Vista
Service Pack 2 or on a computer with

Windows XP Service Pack 3 installed, a warning
message similar to the one shown below

may appear at software activation or USB
connection. Change the computer settings
while referring to the information below.

A screenshot of the warning message in
Windows XP is shown below.

When warning messages appear:

After checking the program name and publisher,
click [Unblock].

J )

If you do not recognize the program, you should
block it because it may be a virus. Click the [Keep
Blocking] button to prevent the program from
connecting to the Internet.

If you clicked the [Ask Me Later] button:

Each time the program is activated, the
[Windows Security Alert] window appears. Then
you can select [Unblock].

If you clicked the [Keep Blocking] button:

Follow the steps below to check to see the
Windows Firewall settings.

Open the [Windows Firewall]
Control Panel.

Open the [Start] menu and select [Control
Panel], then double-click [Windows
Firewall] (if Windows Firewall is not
listed,click [Switch to Classic View] at

the top left corner of the Control Panel
window).

Allow the Ricoh application
Internet access.

—1

In the [Windows Firewall] dialog,click the
[Exceptions] tab and check whether DL-10
is listed under [Programs and Services]. If
it is, place a check in the check box next to
DL-10 and click OK. If it is not listed,click
[Add Program...] to add DL-10 to the list of
exceptions.



Windows 7 Security Warning

On computers running Windows 7, you may
encounter the following warning when starting
Ricoh software for digital cameras either
manually or by connecting a camera:

When warning messages appear:

After checking the program name and publisher,
click [Allow access].

Disconnecting the Camera
from Your Computer

Before disconnecting the camera from the
computer, click the [Safely Remove Hardware]
or [Unplug or Eject Hardware] icon in the
taskbar (the illustration below shows the icon
for Windows XP) and select [Safely remove
USB Mass Storage Device] or [Stop USB Mass
Storage Device] from the menu that appears.
You can then disconnect the USB cable.

If the remove hardware icon is not displayed in
Windows 7, click the [&l button in the taskbar.

)=

« If the USB cable is disconnected without
disabling the connection, the Unsafe Removal
of Device screen may be displayed.

« Do not disconnect the USB cable during
image transfer. Check that image transfer is
completed and be sure to stop the connection
before removing the USB cable.

Detailed Instructions for DL-10

Starting/Exiting DL-10

Starting
DL-10 is already installed with DC Software.
Connecting the camera to your computer

automatically starts the software and begins
downloading of images from the camera.

Exiting
To exit DL-10, follow either of the steps below.

« Click the [MENU] button on the DL-10
window and select [Exit] from the displayed
menu (see “The DL-10 Window").

« Right-click the DL-10 icon on the task bar and
select [Exit] from the displayed menu.

Restarting

To restart DL-10 after exiting, follow the steps
below.

« From the [Start] menu, select [All Programs]
or [Programs] then [DC Software] then
[DL-10].

} )

DL-10 is not network-compatible. Use as a stand-
alone application.



The DL-10 Window

)

nce DL-10 starts up, the following DL-10

window appears on your computer screen.

1

2

J

O

1 2 3 4 5

S O

[MENU] Button
Click this and the following menu appears.

[Option settings] | Specifies where to save
images when downloading
allimages and which
application to start after
images have been saved
or when the [Application]

button is clicked. (IZ& P.11)

[Background Changes the background
illustration design in the DL-10 window.
settings] (IZF"P12)

[CameraMemo] | Transfer images (IZ5 P.19) to
destinations selected based
on the presence or absence
of amemo (IZ&"P.12) and
memo contents.

[About] Displays the version of DL-10.

[Exit] Closes DL-10.

[Save] Button

Click this and the images are downloaded
from your camera.

a

If the message indicating that [Connecting...
Press [Adj.] key to direct print] appears on the
camera picture display, do not click the [Save]
button.
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3 [Application] Button

The application registered in [Option
settings] is started.

[Minimize] Button

Minimizes the window and displays its icon
on the Windows task bar. If you click on the
icon, the window will be displayed again.

Indicator

The “Indicator” lights if the camera is
connected via USB cable. When lit, if you
move the mouse pointer over the “Indicator’,
[Camera is being connected] appears. When
your camera is not connected, the “Indicator”
is grayed out, and if you move the mouse
pointer over it, [Camera is being connected]
does not appear.



How to Use the [Option settings]

Ganlio Software¥0UT0EXE

1—O

If you click the [MENU] button on the DL-10 window and select )—o
[Option settings] from the displayed menu, the [Option settings]

dialog box appears. 3—o

4—o0

} ] -

o 6—o

Note that uninstalling the software for earlier Ricoh cameras may 7—0

reset user preferences for DL-10 or RICOH Gate La.

Item

Description

Initial Setting

[Saves
automatically
when connected
to USB]

Select the check box to have images downloaded and saved automatically
in your computer when the camera is connected to your computer with the
USB cable.

If you deselect the check box, your images will not be downloaded
automatically when you connect your camera to the computer. For
downloading, activate DL-10 and click the [Save] button.

Save
automatically

[Destination folder]

Specifies which folder to save your images in. The [Digital Camera] folder
inside [My Documents] is specified initially; if you want to change this, click
the [Browse...] button to display the dialog box and then specify the folder.

[Create folder]

Specifies how to create a folder.

Create a new

[Not created] folder for
Your downloaded images will all be saved in the folder specified in item each date
“2 [Destination folder]". photographed
[For each date photographed]
Creates a new folder assigning the date the images were shot as the folder
name, and saves images shot on the same day in the same folder.
For example, if shot on January 1,2010:[20100101] folder
[For each time saved]
Creates a new folder each time and save images in the folder. If images are
saved more than once in a day, a new folder is created each time.
The folder name format is “Saving date + Underscore + Three-digit serial
number”.
For example, if you saved twice on January 1, 2010:
[20100101_001] folder, [20100101_002] folder
[The sameimage | When this check box is selected, images once loaded into your computer are | The same
will not be saved] | not loaded again. This check box is enabled only when [Not created] or [For | image will not
each date photographed] is selected in [Create folder]. be saved
To allow this function to work properly, the camera date and time must be set
correctly.
When this check box is deselected, previously loaded images are loaded
again.
* If you were previously using Caplio Software, images will be downloaded
again if images downloaded using RICOH Gate La remain on the SD
memory card even if the [The same image will not be saved] checkbox for
the DL-10 [Option settings] is selected.
[Application To start an application after loaded images have been saved, specify the
software settings] | application name here. Click the [Browse...] button and select the application _
in the displayed dialog box.
[Save and start When this is checked, the application specified above is started after the Application is
application images have been saved. started
software] When this is unchecked, the application is not started.
[Camera's IP Not used for this camera, but used for other Ricoh digital cameras. For details, | 0.0.0.0
Address] see the documentation that came with the camera.

11




How to Use the [Background
illustration settings]

You can select a background for the DL-10
window from three types of patterns.

If you click the [MENU] button on the DL-10
window and select [Background illustration
settings] from the displayed menu, the
[Background illustration settings] dialog box
appears.

I I

1 2

1 [Background illustration pattern]

Select the pattern you wish to use from the
three available.

2 [Preview]

You can preview the pattern selected in
[Background illustration pattern].

12

Using [CameraMemo Settings]

Transfer images to destinations selected
based on the presence or absence of memos
and memo contents. Click the [MENU] button
and select [CameraMemo] to display the
[CameraMemo Settings] dialog.

1—0

2—0

~
o

1 [Transfer From]

Choose the source from [Memory Card
(specify drive or folder)] and [Digital Camera]
in the [Type]l menu. If you select [Memory
card (specify drive or folder)], click the
[Browse...] button and navigate to the desired
source folder.

2 [SaveTo]

Click [Browse...] and choose the destination
for the transferred files. The destination type
is fixed and can not be changed.

3 [Settings...]

Clicking this button displays the [Setting
Information] dialog, where you can adjust
each of the transfer settings listed below by
double-clicking the setting or by selecting
the setting and clicking [Change...].



[Overwrite and
save] (available
only when [Digital
Camera] is selected
for [Transfer From]

Choose whether to include
images that have already
been transferred to the
destination. Select [Do

not save the same image]

to skip images that have
already been transferred.

Choose whether to
transfer all images or only
those with memos.

[Export type]
(available only
when [Memory
Card] is selected
for [Transfer From])

Choose whether the sub-
folders in the destination
folder are named by
memo description or using
both memo item names
and descriptions.

[Transfer mode]

[Launch Choose the application

application] that starts when transfer is
complete.

[Confirm File Choose whether a

Overwrite] confirmation dialog is

displayed before files in
the destination folder are
overwritten by transferred
files with the same name.
If you opt not to display

a confirmation dialog,
files will be overwritten
without warning. If [Digital
Camera] is selected

for [Transfer From], a
confirmation dialog

will only be displayed if
[Save the same image] is
selected.

4 [Begin Transfer]

Click this button to begin transfer (clicking
this button is the only way to begin transfer
using [CameraMemo Settings]).

)=

Reserved characters (\/;?*" < >|) are
automatically converted to underscores (“_")
when memo item names and descriptions are
used as folder names.
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Downloading Images from an
SD Memory Card

It is possible to download images from an SD
memory card to computer via a PC card slot or
card reader.

Images in an SD Memory Card

Images are stored on an SD memory card in a
hierarchy, as shown here.

by

DCIM

] 100RICOH

RIMGO001. jpg
RIMGO002. jpg

[ ]
[ ]
[ ]
Image files

} )

If you connect the camera or a card reader to a
computer and then directly display, edit or save
SD memory card images on the computer, you
may no longer be able to play back the images
on the camera. Download the images to the
computer before displaying, editing or saving
them.

1

Card Reader

This is a device connected to a computer to read
the contents of cards. In addition to the memory
card adapter-type, there are card readers into

which you can directly load an SD memory card.



Chapter 2
Downloading Images
to Your Computer
(Macintosh)

This section explains how to download still images and movies to
your computer (Macintosh).

J )

Although supplied software can not be used on the Macintosh,
Macintosh computers can be used to view the “Software User Guide”
(Acrobat Reader required under Mac OS 9).



Connecting the Camera to a Com-
puter and Downloading Images

Make sure that the camera power is
off.

Connect the accessory USB cable to
a USB port of your computer.

\I/
Connect the USB cable to the USB
terminal of your camera.

&

‘\\3{9 N

Your camera turns on.

Your computer automatically reads the file
necessary for recognizing the camera as a
drive.

After this preparation, the camera is
displayed as a drive on the Desktop.
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From the displayed drive, copy a
file to the desired location.

The figure below shows the folder
configuration in the drive.

RICOHDCX

DCIM

100RICOH

RIMG0001.jpg
RIMG0002.jpg

When the contents of the internal memory
are displayed, the drive name is [RICOHDCI].

- Do not turn off the camera or disconnect the

USB cable during image transfer. The files will
not be written correctly.

Do not use the computer to format the SD
memory card or the internal memory. Use the
camera to format the SD memory card or the
internal memory.

Be sure to stop the connection before
removing the USB cable.

+ Only one Ricoh digital camera can be

connected to one computer. Do not connect
multiple Ricoh cameras to one computer at the
same time.

g

« When downloading images from your camera,

load a battery with adequate remaining power
in the camera.

« If a file with the same name already exists at

the destination, it is overwritten. If you do not
want the file to be overwritten, rename the file
or transfer data to another folder.

When an SD memory card is loaded, its files
are displayed. Otherwise, files in the internal
memory are displayed.



Disconnecting the Camera Downloading Images from an
from Your Computer SD Memory Card

It is possible to download images from an SD
memory card to computer via a PC card slot or

Drag and drop the displayed drive

or volume icon to the [Trash] icon. card reader.
When a screen appears prompting you to
enter the administrator's password, enter Images in an SD Memory Card

the password. Images are stored on an SD memory card in a

hierarchy, as shown here.

Unplug the USB cable.

Q DCIM

« You can also select [Eject] from the [Special] 1 OOR | COH

menu in Mac OS 9 or the [File] menu in

Mac OS X to cancel the connection. R | MGOOO1 . Jpg

A warning may be displayed if the USB cable .
is disconnected without first removing the R l MGOOOZ -JPY

camera from the system as described above.
Be sure to remove the camera from the system
before disconnecting the cable.

Confirm that transfer is complete before Image files
removing the camera from the system and

disconnecting the cable. VE]

« When the camera is connected to a Macintosh %

computer, a “FINDER.DAT” or “.DS_Store”" file
may be created which the camera will list as
an unmatched file. This file can be deleted
without risk.

If you connect the camera or a card reader to a
computer and then directly display, edit or save
SD memory card images on the computer, you
may no longer be able to play back the images
on the camera. Download the images to the
computer before displaying, editing or saving
them.

1

Card Reader

This is a device connected to a computer to read
the contents of cards. In addition to the memory
card adapter-type, there are card readers into

which you can directly load an SD memory card.

16



Chapter 3
How to Use EC1

EC1 is an edit detection software program that allows you to check
and view whether still images taken using the G700SE have been
processed or edited.

J )

In order to carry out edit detection using EC1, you must set [Edit
Detection] to [On] in the camera’s shooting setting menu before
shooting and download the images to your computer.



Using the Edit Detection
Function

You can only carry out edit detection using EC1
after setting [Edit Detection] to [On] on your
camera, shooting still images, and downloading
the images to your computer.

Set [Edit Detection] to [On] in the
camera’s shooting setting menu,
and shoot still images.

For operation procedures, see the “Camera
User Guide”

Download the still images shot
using your camera to your computer.

Select [Programs] (or [All
Programs]) > [EC1] > [EC1] from the
Windows [Start] menu.

From the EC1 Folder View, select the
folder for the downloaded images.
The JPEG images in the selected folder

will be loaded and the images will be
displayed in Thumbnail View after loading
is complete.

L 1
[ [
Folder View Thumbnail View

- [I{ is displayed with images that have
not been processed or edited after
shooting.

- [l is displayed with images that have
been processed or edited after shooting.
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« Neither of the above icons is displayed
with images taken when [Edit Detection]
was set to [Off] or images for which edit
detection is not possible.

« By double-clicking an image in the
Thumbnail View, you can open the
image using the linked viewer software.

- If a space occurs at the beginning or
end of the folder name, a message will
appear and no images will be displayed.

} )

- Edit detection is available only with
photographs taken using cameras equipped
with an edit detection function.

« Images for which the [Resize], [Contrast
Correction], or [Skew Correction] functions
have been used during playback mode will be
labeled as images that have been processed or
edited.

+ When downloading images to your computer,
please use the method for downloading
shown in Chapter 1. Images downloaded
using different methods may be labeled as
processed or edited images even if they have
not been processed or edited.

For example, when you download images

to your computer using “Windows Photo
Gallery” for Windows Vista or “Windows Live
Photo Gallery” for Windows 7, a portion of the
shooting data is edited during the download
process. As a result, the images are labeled as
processed or edited images for ECT.

+ Depending on the software you used to view
images after downloading them, the images
may be labeled as processed or edited images
if you viewed the images or image properties
before saving or closing them.

)

+ For details about how to install EC1, see the
“Camera User Guide”

« For details about downloading images to your
computer, see P5.

Updating Folder Contents

After adding, deleting, or renaming folders,
select [Reload] in the [View] menu to update
the folder and thumbnail lists.



Chapter 4
Shooting with Camera
Memos

You can attach camera memos (information such as shooting
conditions) to the still images you shoot. This section explains
camera memos.

J )

« Be sure to set the date and time on the camera.

« To use the camera memo function, DC Software must be installed.
« Memos are not available with SD WORM memory cards.

« The camera memo function is only for use with Windows.

g

Use MET1 to view and edit the memos that have been appended to
photographs (IZ&” P40).



Section 1
About Camera Memos

Shooting with Camera Memos

The image file storing the image shot with a -
digital camera has an area where additional
information can be stored. The camera memo _ Image
function uses this area to allow you to attach a

memo to the still image you shoot. Image file

Memos make photographs easy to identify and

classify. — Additional

information

Q Camera memo

« Photographer
« Location, etc.

» Memos can not be added to movies.

« Memos can not be added to photographs
taken with [On] or [WB-BKT] selected for [Auto
Bracket] in the camera shooting menu.

Memos

Memos consist of a list of “items” (tags), each with its own “description” (contents). Memos can be
added to photographs by pressing the ADJ./MEMO button and selecting the desired descriptions in
the camera memo dialog before shooting.

(0] 9999 M 4:3F Camera Memo 12

] ** Location [{Exterior

Supervisor [{Beverly Beech
Affiliates  |{Gamma Company

[e1

I 8

FILELIST b vemoon

Items Description
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Using Memos

Create a memo list on the computer and transfer it to the camera (IZ5 P.23).

Use the supplied List Editor application to create and transfer to the camera a memo list file
(extension “mta”) containing memo item names and descriptions.

Take photographs with memos (IZ5°P.27).

Press the ADJ./MEMO button to display the camera memo dialog (IZ&" P.27). After choosing
descriptions, press MENU/OK to create a memo which will be added to all new photographs (if
desired, the contents of the memo can be changed after shooting; IZ& P.29).

The following types of memo are available:

1

Text (IZ5°P.23)

Choose from up to 99 text descriptions created with the
List Editor.

3. Location

a

+ Temporary

Record
02 Entryway
03 Kitchen
04 Living room
05 Bedroom
06 Bathroom

[oise] Cancel [oK | Execute

Temporary memo (IZ5~P.30)

Use the camera to create a temporary memo using
descriptions not included in the memo list. The new
descriptions are not stored in the memo list after the camera
is turned off.

Camera Memo

Delete]
Space]

[@ ] Shift
[oisp] Cancel

[ADJ] Set
[ok] Ok

Voice memos (IZF P.33)
Record voice memos of up to 30 seconds in length.

Shutter button: Start
[Disp]:Cancel

=

Barcodes (IZ5 P.36)

Create temporary memos using text descriptions from
barcodes read using the camera.

Camera Memo 1/45

FileName/SAMPLE

1234567890
Const.type [Foundation work
Location  |Exterior
Supervisor (Beverly Beech
Affiliates  |Gamma Company

Barcode

[Disp | FILE LIST ['0K” Memo On

Images (IZ5” P.38)

To use still images as reference images, include a description
with an image file name when creating the memo list.

Note that the image file must first be copied to the camera
memory card or internal memory.

41125
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Transfer the photos to the computer (IZ5 P.5).
Copy the photos to the computer using the supplied DL-10 software.

View and edit memos (IZ& P.40).

Use the supplied ME1 software to display
photographs, view and edit memos, and play voice
memos.

)=

« Memos will be added to all photographs taken while a memo list file is present in the camera’s internal
memory or on the memory card inserted in the camera.

« Forinformation on installing the supplied software, see the “Software User Guide”,
« The supplied software is available for Windows only.
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Section 2
Creating and Transferring a Memo List

Creating a Camera Memo List

To create a camera memo list, use the provided
software List Editor.

To create a memo list, first create a list of up to
20 items and then create up to 99 descriptions
for each item.

)=

+ A camera memo list file in CSV format created
by a different application can be read into the
List Editor and saved on an SD memory card
for use by the camera.

- To read a csv format camera memo list file into
List Editor, select [Open] from the [File] menu
of List Editor, and then specify the file name.

Starting and Exiting List Editor

Starting List Editor

On the Windows [Start] menu, select [All
Programs] or [Programs] then [Caplio Software]
then [List Editor] to start List Editor.

Exiting List Editor

You can exit List Editor by clicking the [X]
(Close) button in the upper-right corner of the
window or by selecting [Exit] from the [File]
menu.

23

The List Editor Dialog

1-e
2 -@
3 —_
|
4
Item Description
1 | Menu bar Operations that can be performed
using the menus include saving,
editing, and transferring memo lists.
2 | Toolbar Click the icons in the toolbar for

quick access to the following menu
items:

« [@ [New]: Open a dialog where
you can create a new memo list.

- & [Open]: Open a memo list
that you previously saved on the
computer.

. [& [Save]: Save the memo list to
the computer.

« & [Cutl/Ba [Copyl/ & [Paste]:
Cut, copy, or paste selected text.

+ @1 [Transfer to Camera]: Copy the
memo list file to the [TEMPLATE]
folder in the camera’s internal
memory or on the memory card
currently inserted in the camera.

3 | Item name

Name items in the memo list. The

(IZ5°P.24) number of items can be selected
from 20, 10, and 5 using the [Number
of Items] option in the [File] menu.

4 | Details Enter descriptions for the selected

(125" P.24) item.




Using the List Editor

The List Editor is used to create a memo
list containing up to 20 items with up to 99
descriptions for each item.

Choose the number of items in the

memo list.
Select [Number of Items] from the [File]
menu.
Hurmber of ltems gj
e ﬁ ....................... L_l
(] 4 Cancal

Choose the number of items from [5] (the
default setting), [10], and [20]. If desired,
the number of items can be changed after
the memo list is created; note, however,
that if the list contains more items than the
new maximum, the excess items will be
deleted.

Enter item names.

[term name(M]:
|Elient

pdate |

M...| [tem name

Construction type
Location

Lo Rt I e e (R O T

Click an item number, enter a name in the
[Item name] text box, and click [Update]
to display the new name in the item list.
Follow the same procedure to change
existing item names.
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Item names can be up to 20 characters long.
The following characters can not be used:\/:?
*" < > |. Note that the presence of any of these
characters, commas, or multiple periods may
corrupt the display of item names in Russian-
language operating systems.

Enter descriptions.

Select a name in the item list and edit the
descriptions for the selected item.

Dretails:
Input:

Input List:
Compary & Edit
Company B

i

Delete

d

Dgwin

Enter descriptions in the [Input] text
box, and click [Add] to add them to the
end of the input list. Changes to existing
descriptions can be made by clicking the
description and then clicking one of the
following buttons:

- [Edit]: Edit the selected description.
. [Delete]: Delete the selected description.

- [Upl/[Down]: Move the selected
description up or down in the input list.

Descriptions can be up to 32 characters long.
The following characters can not be used:\/:?
*" < > |. Note that the presence of any of these
characters, commas, or multiple periods may
corrupt the display of descriptions in Russian-
language operating systems.



Complete the memo list.

Repeat Steps 2 and 3 to complete the
memo list.

Save the memo list.

Select [Save As] in the [File] menu (memo
lists can also be saved by clicking the &
button in the toolbar).

Confirm that [mta Files (*.mta)] is selected
for [Save as type] (memo lists can be saved
as CSV files, but the mta format must be
used for memo lists intended for transfer
to the camera). After navigating to the
desired location and entering a file name
of up to eight characters, click [Save] to
save the memo list. Note that the camera
can display only file names consisting
entirely of unaccented (low ASCII) roman
characters.

Although lists can be transferred directly
to the camera without being saved, we
recommend that you save the file before
transfer.

25
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To edit an existing memo list, open it using
the [Open] option in the [File] menu. After
editing the list, save it using the [Save]
option in the [File] menu or by clicking the
E button in the toolbar.



Transferring a Memo List File
to the Camera

Memo list files can be transferred to the camera
from the List Editor or using a card reader.

The List Editor

Start the List Editor and connect
the camera.

After starting the List Editor, connect the
camera as described on P6. Exit DL-10 if
it starts when the camera is connected

(IZF"P9).

Transfer the memo list file.

Click the [ & Transfer to Camera] icon in
the toolbar or select [Transfer to Camera]
in the [Tools] menu. If a memory card is
inserted in the camera, the file will be
transferred to the [TEMPLATE] folder on
the memory card; otherwise, it will be
transferred to the [TEMPLATE] folder in
internal memory.

} )

The file will only be transferred if the
destination device contains a [TEMPLATE]
folder. If the destination is a memory
card, be sure it has been formatted in the
camera.

Click [OK].

Exit the List Editor.

Select [Exit] from the [File] menu or click
the close box [x] at the top right corner of
the List Editor window.

Disconnect the camera.

Remove the camera from the system and
disconnect the USB cable as described

on P9 (note that if the connection is not
terminated normally, the memo list file
may not be transferred to the camera). The
memo list will be available for use when
the camera is turned on.

Card Readers

A card reader can be used to copy a memo list
file directly to the camera from the computer.
Copy the file to the [TEMPLATE] folder on the
memory card. A [TEMPLATE] folder is created
automatically when a card is formatted in the
camera.

) peim

F— ] 100RICOH

RIMG0OO1. jpg
RIMG0002. jpg

| TEMPLATE

Deleting Memo List Files From
Memory Cards

To prevent memos from being added to
photographs, use a computer to delete all

“* mta” files from the [TEMPLATE] folder on

the memory card or in the camera’s internal
memory. Memo list files can not be deleted

by formatting the memory card or internal
memory using the format option in the camera
setup menu.



Section 3
Taking Photographs with Memos

Recording Memos with
Photographs

Before proceeding, confirm that a memo list file
has been transferred to the camera’s internal
memory or to the memory card inserted in the
camera.

Adding Memos to New Photos

Select ®3/CALS mode and press
ADJ./MEMO.

The camera memo dialog will be displayed.
Camera Memo 12

FileName/SAMPLE

Client Company A

Const.type |Foundation work

Location  |Exterior
Supervisor |Beverly Beech
Affiliates |Gamma Company

FILE LIST Memo On

If the camera contains multiple memo list
files, the most recently-used file will be
displayed.

While the camera memo dialog is
displayed, photos can still be taken by
pressing the shutter-release button.

Create a memo.
Choose descriptions as described on P.28.

Press MENU/OK.

Press MENU/OK to accept the current
memo.

Take photographs.
The memo will be added to all new photos.

Multiple Memo List Files

If the camera contains more than one memo list
file, press DISP. to display a list of files. Press &
or ¥ to highlight a file and press MENU/OK to
select.

FILE LIST

01 [MISAMPLEOL
02 [SAMPLE02
03 [SAMPLEO3
04 [ SAMPLEO4

05 [so)SAMPLEO5
06 B SAMPLEO6
07 E)SAMPLEO7
08 BN SAMPLEOS

Cancel Execute

g

If [On] is selected for [Display Memo at Startup]
in the camera memo menu, the camera memo
dialog will be displayed automatically at
camera startup.

» Memos will be added to all photographs

taken while a memo list file is present on the
camera. To prevent memos from being added
to photographs, use a computer to delete all
“* mta” files from the [TEMPLATE] folder on
the memory card or in the camera’s internal
memory. Memo list files can not be deleted
by formatting the memory card or internal
memory using the format option in the camera
setup menu.

Note that the camera can display only file
names consisting entirely of unaccented (low
ASClII) roman characters.



Choosing Descriptions

Descriptions can be selected in the camera
memo dialog. The method used depends on
the option selected for [Camera Memo Mode] in
the camera memo menu.

[Mode1]

Highlight an item.
Press A or ¥ to highlight an item.

View descriptions.

Press B> to view descriptions for the
highlighted item.

3. Location

+ Temporary
Record

01 Exterior

02 Entryway

03 Kitchen
04 Living room
05 Bedroom
06 Bathroom

[DisR] Cancel [oK  Execute

Choose a description.

Press A or ¥ to highlight a description
and press MENU/OK to select.

Complete the memo.

Repeat Steps 1-3 to choose descriptions
for the remaining items.

g

« The last option in the list of descriptions is
[No Setting]. Select this option to set the
description for the current item to [No Setting].
Note however that if [On] is selected for [Memo
Warning], a warning will be displayed and the
shutter release will be disabled if you attempt
to take a photograph with the description for
one or more memo items set to [No Setting].
The shutter release can be enabled by choosing
a description for the affected items.

If [On] is selected for [Camera Memo 1 Auto
Delete], the description for the first memo
item will automatically be set to [No Setting]
when the camera is turned on, a photograph
is taken, or a memo list is transferred to the
camera. The shutter release can be enabled by
choosing a description for the first item.
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[Mode2]

When the camera memo dialog is first
displayed, the description for each item will be
set to the first entry in that item’s description
list. Press P> once to set the description for each
item to the second entry in the description

list, twice to set the description for each item
to the third entry in the description list, and

so on. Press d to return to the previous set of
descriptions.

Camera Memo

FileName/SAMPLE

Client Company A
Const.type |Foundation work
Location  |Exterior
Supervisor |Beverly Beech
Affiliates  |Gamma Company

FILE LIST Memoon || |

Shows the position of the current memo and
the total number of combinations available. In
this example, the current memo uses the first
combination.

Press A or ¥ to choose the item displayed. The
descriptions for individual items can not be
selected separately.

)=

To skip to the previous or next combination

that contains a unique description for the item
selected for [Memo Skip] in the camera memo
menu, press and hold d or P>. The following
table gives an example of the combinations that
would be skipped when [Item 1] is selected.

Item | Description 1 | Description 2 | Description 3 | Description 4

1T [A A A

»B

The item used for [Memo Skip] can selected from
items 1-5.



Viewing Memos

Follow the steps below to view and edit photos
that have been added to photographs.

} )

Memos can not be deleted.

« Camera memos can only be edited as

described below when [Mode1] is selected for
[Camera Memo Mode] in the camera memo
menu. In Mode2, memos can be displayed by
pressing DISP. during playback but can not be
edited.

Viewing Memos

Display the desired photo in
playback mode.

Photographs to which memos have been
added are indicated by a“MEMO” icon.

Press ADJ./MEMO.

The memo will be displayed as shown
below. Press & or ¥ to view additional
data.

Camera Memo 112

FileName/SAMPLE

Client Company A
Const.type |Foundation work
Location  |Exterior
Supervisor Beverly Beech
Affiliates  |Gamma Company

Press MENU/OK.

Press MENU/OK to return to normal
playback.
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Editing Memos

Display the desired photo in
playback mode.

Photographs to which memos have been
added are indicated by a“MEMQO” icon.

Press ADJ./MEMO.

The memo will be displayed as shown
below.

Camera Memo 112

FileName/SAMPLE

Client Company A
Const.type |Foundation work
Location  |Exterior
Supervisor Beverly Beech
Affiliates  |Gamma Company

[ ok ] Memo On

Select an item.

Press A or ¥ to highlight an item and
press P> to view descriptions for the
highlighted item.

3. Location

+ Temporary
Record

01 Exterior

02 Entryway
03 Kitchen
04 Living room
05 Bedroom
06 Bathroom

Cancel Execute
Choose a description.

Press A or ¥ to highlight a description
and press MENU/OK to select.

Press MENU/OK.

Press MENU/OK to return to normal
playback.



Creating a Temporary Memo Select [Yes].

o Press € or P> to highlight [Yes] and press
Memo descriptions can be created on the MENU/OK.

camera (either by editing existing descriptions
or creating entirely new descriptions) and the
resulting “temporary memo” appended to new
photos. Temporary memos can be created in
both shooting and playback mode.

)=

« Temporary memos are not stored in the memo
list after the camera is turned off.

« Temporary memos can be created using
barcodes (IZ5”P.36).
« Temporary memos are available only when

[Mode1] is selected for [Camera Memo Mode] Create a temporary description.
in the camera memo menu.

An on-screen keyboard will be displayed.
. Use the keyboard to enter a temporary

Creating a Temporary Memo description as described on P.49.
To create a temporary memo, display the

camera memo dialog and follow the steps Camera Memo

below.
Select an item. [[gelete]]
ace
Press A or ¥ to highlight an item and p_ +

press P> to view descriptions for the
highlighted item.

"

Select [Temporaryl. Shift Set
Cancel Ok

Press A or ¥ to highlight [Temporary] and

press MENU/OK. After entering the description, press ADJ./

3. Location MEMO to return to the description list.
rary Select the temporary description.
Exterior Press A and ¥ to highlight the temporary
Entryway description and press MENU/OK to select
E,”‘?he” (to exit without saving the temporary

'Ying room description and restore the description
Bedroom .
Bathroom previously selected, press DISP.). Repeat
Steps 1-4 to create additional temporary
D?] Cancel oK Execute descriptions as desired.
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Editing the Temporary Memo

Select an item.

In the camera memo dialog, press & or ¥
to highlight an item for which you have
created a temporary description and press
P to view descriptions for the highlighted
item.

Select a temporary description.

Temporary descriptions are indicated by a
“+" Press A& or ¥ to highlight a temporary
description and press P.

3. Location

Temporary
Record
Exterior

Entryway

Kitchen
Living room
Bedroom
Bathroom

Cancel OK_ Execute

Edit the description.

Edit the description as described in Steps
3-5 of “Creating a Temporary Memo.’
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Creating a Temporary Memo from an
Existing Memo

Create a temporary memo by editing an
existing memo.

Select an item.

Press A or ¥ to highlight an item in the
camera memo dialog and press P> to view
descriptions for the highlighted item.

Select a description.

Press A or ¥ to highlight a description
and press P

3. Location

+ Temporary
Record

01 Exterior

02 Entryway

03 Kitchen
04 Living room
05 Bedroom
06 Bathroom

Cancel Execute

Edit the description.

Edit the description as described in Steps
3-5 of “Creating a Temporary Memo.’

g

Edited descriptions are stored as a temporary
memo. The original descriptions are not affected.



Memo Increment

If a memo description ends in a number,
you can increase or decrease the number by
pressing A or V.

} )

Memo increment is available only when [Mode1]
is selected for [Camera Memo Mode] in the
camera memo menu.

Using Memo Increment

Transfer to the camera a memo list file
containing descriptions that end in numbers
and follow the steps below.

Select [On] for [Memo Increment].

Select [On] for [Memo Increment] in the
camera memo menul.

Select an item.

Press A or ¥ to highlight an item in the
camera memo dialog and press P> to view
descriptions for the highlighted item.
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Select a description thatendsina
number.
Press A or ¥ to highlight a description

that ends in a number and press P> to
display the memo increment dialog.

Camera Memo

No.102

[a¥] Change Number
Ok

Cancel

A warning will sound if you select a
description that does not end in a number.

Edit the number.

Press A or ¥ to choose a new number and
press MENU/OK twice to return to shooting
mode. The new number will be recorded
with the next photograph taken.

g

The new number is stored as a temporary memo.
The original description is not affected.



Using Memo Increment with
Temporary Memos

Memo increment can be used with temporary
memos.

Create a temporary description
that ends in a number (IZ5°P.30).

Select [On] for [Memo Increment].

Select [On] for [Memo Increment] in the
camera memo menu.

Select the item.

In the camera memo dialog, press & or ¥
to highlight the item with the temporary
description you created in Step 1 and press
P to view descriptions for the highlighted
item.

Select the temporary description.

Temporary descriptions are indicated
by a“+". Press A or ¥ to highlight the
description and press P> to display the
memo increment dialog.

Camera Memo

No.102

[a¥ Change Number
Cancel [ok_ Ok

Edit the number.

Press A or ¥ to choose a new number and
press MENU/OK twice to return to shooting
mode. The new number will be recorded
with the next photograph taken.
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Voice Memos

Each item in a memo can have as a description
an audio recording of up to 30 seconds in
length. Voice memos can be created and edited
in both shooting and playback mode.

g

« Voice recordings are deleted from the memo
list when the camera is turned off. Voice
recordings already stored in memos that have
been appended to photos are not affected.

» Voice memos can be played back on the
computer when photographs are displayed in
the supplied ME1 software.

Recording Voice Memos

Select an item.

Press & or ¥ to highlight an item in the
camera memo dialog and press P> to view
descriptions for the highlighted item.

Select [Record].

Press & or ¥ to highlight [Record] and
press MENU/OK to display the recording
dialog.

3. Location

+ Temporary

01 Exterior
A EY

03 Kitchen
04 Living room
05 Bedroom
06 Bathroom

Cancel Execute



Record a voice memo.

Press the shutter-release button to begin
recording.

eREC

Shutter button: Start

Recording ends after 30 seconds or
when the shutter-release button is
pressed halfway. The description list
will be displayed with a P> icon next to
the [Record] option (in playback mode,
[Record] changes to [Playback]).

3. Location

+ Temporary
Record
01 Exterior

02 Entryway

03 Kitchen
04 Living room
05 Bedroom
06 Bathroom

Cancel OK_ Execute

Press MENU/OK.

Items for which a recording exists are
indicated by a %) icon in the camera memo
dialog.

Camera Memo 12

FileName/SAMPLE

Client Company A
Const.type |Foundation work
Location

Supervisor Beverly Beech
Affiliates  |Gamma Company

FILE LIST [ ok | Memo On
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+ Do not obstruct the microphone during
recording. Keep microphone within 20cm
(7.8in.) of the source.

+ Voice memos are not available with matrix
barcodes. The [Record] option is not displayed
in the description list when a matrix barcode
type is selected.

Playing Voice Memos

Voice memos can only be played back in
playback mode.

Select an item for which a
recording exists.

In the camera memo dialog, press & or ¥
to highlight an item marked with a %) icon
and press P> to view descriptions for the
highlighted item.

3. Location

+ Temporary

Playback

01 Exterior
02 Entryway

03 Kitchen
04 Living room
05 Bedroom
06 Bathroom

[DISP] Cancel [OK'| Execute

Select [Playback].
Press A or ¥ to highlight [Playback] and
press P> to display the playback dialog.

[so]

00:00

Shutter button: Start
[DsR]:Cancel




Play the recording. Re-recording Voice Memos

Press the shutter-release button to play the Follow the steps below to edit voice memos in
recording. shooting mode.

Playback ends when the end of the . .
recording is reached or when the shutter- Select .an Item for which a

release button is pressed halfway. A recording exists.

confirmation dialog will be displayed. In the camera memo dialog, press & or ¥
to highlight an item for which a recording
exists and press P> to view descriptions for
the highlighted item.

To re-record the memo as described in
Step 3 of “Recording Voice Memos,” press
4 or P to highlight [Yes] and press MENU/
OK. Select [No] to return to the description 3. Location
list without modifying the recording.

+ Temporary

01 Exterior
02 Entryway

03 Kitchen
04 Living room
05 Bedroom
06 Bathroom

Cancel Execute

Select [Record].

Press & or ¥ to highlight [Record] and
press P> to display the recording dialog.

Shutter button: Start
[Disk]:Cancel =

Re-record the voice memo as described in
Step 3 of “Recording Voice Memos.”
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Registering Barcode Data as a
Temporary Memo

The camera can read barcodes and store the
data as temporary descriptions for temporary
memos. Barcodes can be read in both shooting
and playback mode.

)=

« The camera can read linear barcodes of up to
32 digits and matrix barcodes of up to 2400
digits. The barcode type can be selected using
the [Barcode Type] option in the camera memo
menu.

« Voice memos are not available with matrix
barcodes. The [Record] option is not displayed
in the description list when a matrix barcode
type is selected.

Choosing a Barcode Mode

The [Barcode Mode] option in the camera
memo menu can be used to choose where
barcode data are stored.

Mode1 | The barcode is stored in the memo list as
a temporary description for the first item.
This description is overwritten each time a

barcode is read.

The first barcode read is stored in the memo
list as a temporary description for the first
item, the second barcode as a temporary
description for the second item, the third
barcode as a temporary description for

the third item, and the fourth barcode as a
temporary description for the fourth item.
These descriptions are overwritten in turn as
new barcodes are read.

Mode2

Mode3 | This option only takes effect in shooting
mode. Up to fifty barcodes can be stored in
the memo list as temporary descriptions for
the first item. These data can be viewed in
the camera memo dialog before shooting but
can not be changed and are deleted after a

photograph is taken.
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Reading a Barcode and Registering
Barcode Data

Shooting Mode
Press the ADJ./MEMO button.

The [Camera Memo] screen appears.

Point the camera toward the
barcode you want to read and press
the € button.

The camera switches to macro mode and
reads the barcode data. When the camera
finishes reading the barcode, the data are
stored as a temporary description for the
first item in the memao.

Camera Memo 1/45

FileName/SAMPLE

1234567890
Const.type |Foundation work
Location  |Exterior
Supervisor |Beverly Beech
Affiliates |Gamma Company

Barcode

FILE LIST Memo On

If the camera is unable to read the barcode
or if you wish to exit without reading the
barcode, press P> or DISP. to return to the
camera memo dialog. Press 4 to read the
barcode again.

Non-ASClIl characters in the barcode data
will be replaced by asterisks (“*”).

Read additional barcodes.

If [Mode2] or [Mode3] is selected for
[Barcode Mode], repeat Step 2 to read
additional barcodes.



Press MENU/OK to accept the new
memo.

The new memo will be recorded with the
next photograph taken.

To delete barcodes read with [Mode3]
selected for [Barcode Mode], highlight the
first item in the camera memo dialog and
press P> to display the description list. Press
A or V¥ to highlight [No Setting] and press
MENU/OK.

Non-ASClIl characters in the barcode data
will be replaced by asterisks (“*”).

When [Barcode Mode] is set to
[Mode2], you can repeat Step 4 and
read additional barcodes.

Press the MENU/OK button to
confirm the camera memo.

Press the MENU/OK button.
The memo will be added to the

Playback Mode photograph.

Display a photograph. VE]

Display a photograph to which you wish to =
add barcode data.

Press the ADJ./MEMO button.

The [Camera Memo] screen appears.

Press the € button.
You can now read barcode data.

Point the camera toward the
barcode you want to read and press
the € button.

The camera switches to macro mode and

reads the barcode data. When the camera
finishes reading the barcode, the data are
stored as a temporary description for the

first item in the memo.

Camera Memo 1/45

FileName/SAMPLE

1234567890
Const.type |Foundation work
Location  |Exterior
Supervisor |Beverly Beech
Affiliates |Gamma Company

Barcode

If the camera is unable to read the barcode
or if you wish to exit without reading the
barcode, press P> or DISP. to return to the
camera memo dialog. Press d to read the
barcode again.
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« You cannot read the same barcode more than
once.

- If, after reading the barcode, you shoot a
picture or change modes and then read
another barcode, the previously registered
barcode data is overwritten.

« If you edited the camera memo before reading
a barcode, the changes to the camera memo
are not retained if the camera is unable to
read the barcode. However, voice memos are
retained.

)=

+ You can edit the barcode data registered as a
temporary memo. (IZ5"P.31)

+ The time available to read barcodes can be
selected using the [Scan Time] option in the
camera memo menu.



Image Memos

To use still images as memos, include a
description with an image file name when
creating the memo list. Note that the image
file must first be copied to the camera memory
card or internal memory.

} )

Image memos can be viewed only when [Mode2]
is selected for [Camera Memo Mode] in the

camera memo menu. No image will be displayed
if a file with the selected name can not be found.

First Steps

Enter the image file name as a
description.

Using the supplied List Editor application,
enter the file name of the desired image as
a description for the last item in the item

list (125 P.23).

Dretails:
Imput;

Imput List:
007.jpg Edit
002.jpg
03 jpg Delete

Dawin

i

} )

« Enter the file name as the description for the
last item in the item list. The image will not
be displayed if the file name is entered as a
description for other items in the list.

+ Image memo file names must end in the“jpg”
extension.

Connect the camera to the

computer.

See “Downloading Images Without Using
DL-10" (IZ& P.6) for more information.
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Copy the image to the camera.

Copy the image to the [TEMPLATE] folder
in internal memory or on the camera
memory card.

o

3 ] 100RICOH

RIMG0OO1. jpg
RIMG0002. jpg

11

| TEMPLATE

001. jpg
002. jpg

g

Image memos must satisfy all the following

criteria:

- File type: JPEG

+ Color space: YCbCr4:2:20r4:2:0

« Dimensions (W xH): From 32x32 to
4000 x 3000 pixels, where the width is a
multiple of 16 and the height a multiple of 8
(YCbCr4:2:2)or 16 (YCbCr4:2:0)

- File size: 12 MB or less



Viewing Image Memos

Shooting Mode

To view image memos, press ADJ./MEMO in the
camera memo dialog. Press ADJ./MEMO again
to return to the camera memo dialog.

Camera Memo 1/45

FileName/SAMPLE

Client Company A
Const.type |Foundation work
Location  |Exterior
Supervisor |Beverly Beech
Affiliates |Gamma Company

FILE LIST [ ok | Memo On

ADJ./MEMO button ‘v

/25

Playback Mode

To view an image memo that has been
appended to a photograph, display the
photograph and press ADJ./MEMO.

Cfflent  CompemyA
Foundeiion
Supeniser
Affiliates

ADJ./MEMO button ‘v

Press A, ¥, 4, or P> to return to playback and
display other photographs.

i)

No image memo will be displayed if a file with
the selected name can not be found.
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Section 4
Viewing/Editing a Camera Memo
on a Computer

Using ME1

Once photographs have been transferred to
the computer, the supplied ME1 software can
be used to display photographs, view and edit
memos, and play voice memos.

Select [Programs] (or [All Programs]) >
[DC Software] > [ME1] from the Windows [Start]
menu to start the software.

The ME1 Window

1-e
2 —
I
3
Item Description

1 | Menu bar | Operations that can be performed
using the menus include printing and
viewing photographs.

2 | Folderlist | A list of the folders on the computer.
Click a folder to display any photographs
it contains in the thumbnail list.

3 | Thumbnail | A list of the photographs in the selected

list folder. Double-click a thumbnail to
display the photograph full frame. The
following icons are displayed under the
photos in the thumbnail list:

- 8] (GPS icon): Double-click this icon
to display GPS data recorded with the
photo. If no GPS data are recorded
with the photo, this icon will be
grayed out and unavailable.

« || (memo icon): Double-click this
icon to edit the memo appended
to the photo. If no memo has been
added to the photo, this icon will be
grayed out and unavailable.
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Editing Memos

To edit the memo for a selected photo, double-
click the [l icon in the thumbnail list. The edit
dialog will be displayed.

2 —
3 T
4
5—e
6
7 I |
8 1|
Iltem Description
1 |Item A list of the items in the memo.
2 | Voice memo | The icons for items that contain voice
icons memos are displayed in red.
3 | Memo The descriptions for the items in the
item list.
4 | [Play Voice Click to play the voice memo for the
Memo] selected item.
button
5 | Edit Memo Lists the item name and description
for the item selected in the item
list. The name and description
can be edited by typing in the
corresponding text box (the
following characters can not be used:
\/: 2% <> ).
6 | [Apply] Click to apply the changes in the
button [Edit Memo] panel.
7 | [Save] Save changes and close the edit
button dialog.
8 | [Cancel] Close the edit dialog. Any changes
button made since the last time you clicked
the [Apply] button will be lost.




} )

+ No photographs will be displayed if a space
occurs at the beginning or end of the folder
name. Edit the folder name.

« Note that the presence of commas, multiple
periods, or any of the following characters may
corrupt the display of item names in Russian-
language operating systems:\/:? *" <> |

Printing Memos with Photographs

Select [Print] in the [File] menu to print memos
with photographs. Printer settings can be
adjusted by selecting [Settings] in the [File]
menu.

Print Samples

Single photo printed with memo on an A4 sheet

CimyPicture 201010101

RIMGO001.jng 2010001110

Two photos printed with memos on an A4 sheet

CimyPicture 201010101

1

Three photos printed with memos on an A4 sheet

CimyPicture

RIMGO001 jpg

RIMGO00Zjpg

RIMGO003jpg

g

+ Photos can be printed without memos.

+ The number of memo items that can be
printed with three photos on a single sheet
varies with printer settings.



Section 5
Using Memos to Sort Photos

Using EX1

The supplied EX1 software can be used to:

» Rename photographs or organize
photographs into folders using memo
data, allowing you to get an idea of memo
contents from the image file names

+ Export memos in CSV, XML, or TXT format

EX1 is available in client and server versions. The
server version (“EX1 for Server”) continuously
monitors a selected source folder for new
images and automatically processes them as
they are added to the folder. The client version
(“EX1 for Client”) does not process images
automatically.

EX1 Operation Flow

Copy photos to the computer
(125" P.5).

Copy photographs with memos to the
computer, either using DL-10 or by another
method.

Adjust transfer settings (IZ5” P.43).
Choose source and destination folders.

Process photographs.

The server version of EX1 automatically
processes photos as they are added to the
source folder (IZ5 P.45); to process photos
using the client version, select [Programs]
(or [All Programs]) > [EX1 for Client] >
[Transfer] from the Windows [Start] menu

(125~ P45).
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Starting and Exiting EX1

EX1 for Server

When installed using the default installation
options, EX1 resides permanently in the system
tray. To close EX1, click the icon in the system
tray and select [Quit].

Transfer Settings. ..
Property...
v Enable a folder monitoring

Abaut, .,

Lo |

B

To restart EX1, select [Programs] (or [All
Programs]) > [EX1 for Server] from the Windows
[Start] menu.

EX1 for Client

To adjust settings, select [Programs] (or [All
Programs]) > [EX1 for Client] > [Setting]

from the Windows [Start] menu. To process
photos, select [Programs] (or [All Programs]) >
[EX1 for Client] > [Transfer]. To exit EX1, close
the transfer settings dialog. EX1 will terminate
automatically when processing is complete.



Transfer Settings

EX1 for Server

Clicking the EX1 icon in the system tray with
the right mouse button displays the following
transfer settings dialog.

f; Transfer Settings E|
1 __.[1]Transfer From
g Press [Browse] and specify the folder storing the files to be processed.
The Transfer From Browse(G)...
2 1 O02] Process:
0 Select the process. Press [Detail] for the custarmization.
‘Eamera mema extraction j DetailE]...
3 __.[3] SaveTo
g Press [Browse] and specify the folder where the files are saved after processing.
A different falder from the original folder needs to be specified.
The Save To location is nat st Browse(T])...
4 Ok | Cancel |
Iltem Description
1 | Transfer Click [Browse...] to choose the
From watched folder.
2 | Process Choose how photographs will be
processed.

- Camera memo extraction: Rename
files according to memo contents
and transfer them to the selected
destination folder, or export memos
in CSV, XML, or TXT format.

« Camera memo category: Create sub-
folders in the selected destination
folder named according to memo
contents and transfer files to the
appropriate sub-folders.

Click [Detail...] to adjust settings for

the selected option (IZ5 P44).

3 | SaveTo Click [Browse...] to choose a
destination folder.
4 | [OK] button | Save changes and exit.
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EX1 for Client

Select [Programs] (or [All Programs]) >
[EX1 for Client] > [Setting] from the Windows
[Start] menu.

X

3 Transfer Settings

1 7 _.[1 1 Transfer From

g Presz [Browse] and specify the folder staring the files to be processzed

The Transfer From location is not set.

Browse(G)..

2 O] Froces:

0 Select the process Press [Detail] for the customization

v|  DetsilE]..

|Eamera memo extraction

4

Prezz [Browse] and specify the folder where the files are saved after processing
A, different folder from the original folder needs to be specified.

3 __.[3] Save To
=

The Save To location is not set. Browse(T)...

7 _3 Display confimnation dialog before transfer begins. [C) 0k | Cancel |
 — |

Iltem Description

Click [Browse...] to choose the
folder containing the images you
intend to process.

1 | Transfer From

2 | Process Choose how photographs will
be processed as described under
“EX1 for Server.”

3 | SaveTo Click [Browse...] to choose a
destination folder.

4 | [Display Select this option to display

confirmation
dialog before
transfer begins]

a confirmation dialog before
transfer begins (IZ5° P45)

5 | [OK] button Transfer photos. The original files
will be deleted when transfer

is complete. (The first time you
start EX1 for Client, this button is

displayed as [Begin Transfer].)

g

If [Camera memo extraction] is selected for
[Process], reserved characters (\/:?*" <> |) are
automatically converted to underscores (“_")
when memo item names and descriptions are
used as folder names.




Process > Detail

Clicking [Detail...] in the [Process] panel displays
the following dialog.

Detailed setting of the processing El
Process: Camera mema extraction
Setting Information Listly):
Select the item to be changed and press [Change].
Bibliographic infarm..
Fename Syntax
Expart Farmat
Change(C]

The items in the setting information list depend
on the option selected in the [Process] panel. To
change settings, highlight an item in the setting
information list and click [Change...].

Camera Memo Extraction > Rename Syntax

Rename Syntax ﬁ

Select mema fislds for renaming,
Selection

¥ Memo Field T <Memol>

¥ Memo Field 2 <Memo2>

¥ Memo Field 3 <Memo3>

R Memo Fisld 4 <Memod>

W Memo Field 5 <MemoSs

[ Memo Field B <Memob>
[ Memo Field 7 <Mema7>
[ Memo Field 8 <Memo8>
I Memo Field 9 <Memad>
I~ Memo Field 10 <Memol0>

[ MemoField 17 <Memo113
[ Memo Field 12 <Memo12>
[ Memo Field 13 <Memo133
I~ Memo Field 14 <Memald>
I~ Mema Field 15 <Memal5>

[~ Memo Field 16 <MemalB>
[~ Memo Field 17 <Memal 7>
[~ Memo Field 18 <Memal8>
I~ Memo Field 13 <Memal9>
I~ Memo Field 20 <Mema20>
W GFS Conrdinale <GPS

Jv Datetime<Date>

Preview:
Display selected mema fislds as <>,

emol_Memo2_Memo3_Memod_Memo5_GFS_Date

Cancel

Choose the memo items that will be used to
rename files. If multiple items are selected, they
will be separated by an underscore (“_") in the
file name.
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Camera Memo Extraction > Export Format

Select the format or formats that will be used to
export memos. Memos will not exported if no
options are selected.

Camera memo category > Transfer Mode

Transfer mode

Sl the transhar mods

v Transder o ltem_cortents fokderd]]
1 Traneder o Contents foldea(M]

ok, Carcel |

Choose whether folder names will consist of
the item name and description separated by an
underscore (“_") or simply the description.

Example: Given the following camera memao...

Item Name Description
Item 1 Description A
Item 2 Description B
Item 3 Description C
Item 4 Description D

...the following folders will be created using
the item names and descriptions:

Item 1_Description A

Item 1_Description B

Item 1_Description C

Item 1_Description D



Processing Photos

EX1 for Server

If folder monitoring is enabled, EX1 will monitor
the folder selected in the transfer settings
dialog and automatically process images as
they are added to the folder. Disable folder
monitoring to prevent images from being
processed automatically.

Transfer Settings...
Property...

B

If a transferred file is found to be damaged or
corrupt, a message will be displayed and transfer
will end automatically.

EX1 for Client

Select [Programs] (or [All Programs]) >

[EX1 for Client] > [Transfer] from the Windows
[Start] menu. If [Display confirmation dialog
before transfer begins] is selected in the
transfer options dialog, the following dialog
will be displayed. Click [Transfer] to transfer the
images.

X

Transfer From and Save To Locations

F-5\Diocuments and SettingstU seribdy Documentsibd

4

Camera memo extraction

4

F-\Diocuments and SettingsiUsert. . \Digital Camera

Tranzfer From:

Process:

Save To:

Once the '"Transfer' button is preszed. tranzfer will begin.

Tranzfer |

Cancel

)=

The original files are deleted after transfer.
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Property

To open the EX1 for Server properties dialog,
right click the EX1 icon in the system tray.

1—e

2—e

Item

Description

1 | Setting for
application
launching

Choose whether folder monitoring is
enabled by default.

2 | Enable the
output of
transfer log

Choose whether a log file will be

created when images are transferred.

- Browse...: Choose a destination for
the log file.

« Maximum file size: Choose the
maximum size for the log file.

« History of file number: Choose
the number of files included in the
transfer history.




File Information

The information below is included in files
created using [Export Format].

This example assumes that the following file is

transferred:

File Description

Item

Content

Date of recording

2010.10.10 00:00:00

GPS data

None

Memo Contents

Item Name Description
Item 1 Description A
Item 2 Description B
Item 3 Description C
Item 4 Description D
Item 5 Description E
XML Format

Main Tag Name

Content

DateTimeOriginal

Shooting date of the image file

GPSLatitudeRef Latitude (N or S)
GPSLatitude Latitude (Numeric value)
GPSLongitudeRef | Longitude (E or W)
GPSLatitude Longitude (Numeric value)
CameraMemol - Item names and descriptions
CameraMemo5 P
Memoltem - Item names

Memoltem5

MemoData1- Descriptions

MemoData5 P
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<?xml version="1.0" encoding="Shift_JIS"?>
<Exif>

<APP1>
<Exif_IFD>
<DateTimeOriginal>2010:10:10 00:00:00
</DateTimeOriginal>
</Exif_IFD>
<GPS_IFD>
<GPSLatitudeRef>N</GPSLatitudeRef>
<GPSLatitude>00:00:00</GPSLatitude>
<GPSLongitudeRef>E</GPSLongitudeRef>
<GPSLongitude>00:00:00</GPSLongitude>
</GPS_IFD>
</APP1>
<APP5>
<CameraMemo1>
<Memoltem1>Item 1</Memoltem1>
<MemoData1>Description A</MemoData1>
</CameraMemo1>
<CameraMemo2>
<Memoltem2>Item 2</Memoltem2>
<MemoData2>Description B</MemoData2>
</CameraMemo2>
<CameraMemo3>
<Memoltem3>Item 3</Memoltem3>
<MemoData3>Description C</MemoData3>
</CameraMemo3>
<CameraMemo4>
<Memoltem4>Item 4</Memoltem4>
<MemoData4>Description D</MemoData4>
</CameraMemo4>
<CameraMemo5>
<Memoltem5>Item 5</Memoltem5>
<MemoData5>Description E</MemoData5>
</CameraMemo5>

</APP5>
</Exif>



CSV Format

Main Tag Name Content
DateTimeOriginal | Shooting date of the image file
GPSLatitudeRef Latitude (N or S)

GPSLatitude Latitude (Numeric value)
GPSLongitudeRef Longitude (E or W)
GPSLatitude Longitude (Numeric value)
(Memo item The above information is
names and followed by the memo item
descriptions) names and descriptions.

DateTimeOriginal,2010:10:10 00:00:00
GPSLatitudeRef,N
GPSLatitude,00:00:00
GPSLongitudeRef,E
GPSLatitude,00:00:00

Item 1, Description A

Item 2, Description B

Item 3, Description C

Item 4, Description D

Item 5, Description E
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TXT Format
Main Tag Name Content

DateTimeOriginal | Shooting date of the image file
GPSLatitudeRef Latitude (N or S)
GPSLatitude Latitude (Numeric value)
GPSLongitudeRef Longitude (E or W)
GPSLatitude Longitude (Numeric value)
CameraMemo1- Memo item names and
CameraMemo5 descriptions

[DateTimeOriginal]
2010:10:10 00:00:00
[GPSLatitudeRef]
N

[GPSLatitude]
00:00:00
[GPSLongitudeRef]
E

[GPSLatitude]
00:00:00
[CameraMemo1]
Iltem 1

Description A
[CameraMemo?2]
Item 2

Description B
[CameraMemo3]
ltem 3

Description C
[CameraMemo4]
Iltem 4

Description D
[CameraMemo5]
ltem 5

Description E



Appendices




How to Use the Keyboard

To use the keyboard, follow the steps below.

Memo area

Camera Memo

[Delete]
[Space]
| -

+

n

Shift Set
Cancel 0k

Keyboard area

Enter a description of up to 32 characters.

Highlight characters using A, ¥, 4, or B> and press MENU/OK to enter the highlighted
character at the current cursor position (to delete the character at the current cursor position,
select [Delete]). Press T to shift between upper and lower case. To exit without changing the
description, press the DISP. button.

Press ADJ./MEMO.
Press ADJ./MEMO to save the description and exit the keyboard entry dialog.
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Troubleshooting

Problem 1 Cannot download images

Solution 1
Your camera may not be recognized correctly if you connect to the USB Port of your computer via a USB hub.
Follow the steps below to change the USB port.

« Connect your camera directly to the USB port of your computer.

« If there are several root hubs, change to another hub.

If you are using a non-USB hub, try connecting via a USB hub.

Solution 2
The battery in the camera may have worn out.

Before downloading images from your camera, load a battery with adequate remaining power in the
camera.

Solution 3
The free space on the hard disk in your computer may be insufficient.
Check whether the hard disk has sufficient space for running Windows, and whether the drive where

you are loading image files has the same capacity or more as that of the SD memory card inserted in
the camera.

Problem 2 Even if you check [The same image will not be saved] in the DL-10 [Option settings], the
same images are loaded into your computer.

Solution
The camera's clock is incorrectly set or the camera's clock information has been reset.

To allow the [The same image will not be saved] function to work properly, the camera's clock
information must be set properly. Set it properly.

Problem 3 Files loaded from the camera into the computer were deleted. You attempted to load
the same files from the camera again but failed.

Solution

If [The same image will not be saved] is checked in the DL-10 [Option settings], files loaded into your
computer once cannot be loaded again. In the DL-10 [Option settings], uncheck [The same image will
not be saved].

Problem 4 [Failed to save.] appears during image loading from the camera into your computer

Solution

Set the camera to playback mode and check that [Unmatched File] is not displayed for any file. If
[Unmatched File] is displayed, delete the file from the SD memory card or internal memory after
backing up all files on your computer. To back up the files in the camera, copy all files into your
computer directly by using a commercially-available card reader or by connecting the camera to the
computer using the USB cable provided.
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